
2 Hyperview Browser

2.1  How to run Hyperview, load an M14 file, and get help

DBDOC organises all your INFI 90 documents into a single package to give you fast, easy, read-only access
to the information you need to do your job. Hyperview is the browser that navigates through this view of your
system.

2.1.1  How to Run Hyperview

2.1.1.1  Starting Hyperview from inside BuildPlus

To launch Hyperview from inside BuildPlus you can use one of the following methods:

A shortcut to Hyperview created by the DBDOC administrator for your part of the plant· 
OR Open a project in BuildPlus and click the View M14 File  button to bring up the M14 file selections
and open Hyperview.

· 

2.1.1.2  Starting Hyperview from a shortcut

The shortcut via the Start  button - under Programs  look for either a GMCL DBDOC or GMCL DBDOC
Hyperview  folder and click on the Run Hyperview  option.

 Note:  This method opens the last M14 file viewed.

2.1.1.3  Launching an additional Hyperview window

You can also launch a new Hyperview window by selecting the New Window  option from the File  menu
inside of Hyperview. This will launch another copy of Hyperview to the same M14 and topic that you are
currently viewing. The new copy will inherit the same command line parameters as the copy that spawned it.

2.1.1.4  Advanced: Running Hyperview from the command line

Command Line Options:

You can launch Hyperview via the command line. You may specify the name of the M14 file to open, as well
as, optionally, a particular document within the M14 to display when it first opens up. You may also append
additional optional arguments.

The command line takes the following form:

Installed_program_location>\Hyperview_winsock.exe" 
<M14 filename>
</document_switch=document_name>
</additional_optional_switches>

In practice this will take one of three forms:

Specifying a general document to open:

Installed_program_location>\Hyperview_winsock.exe" 
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/dr SODG Graphic /dr="G40"

/dis SODG Graphic /dis="G41"

/dwg AutoCAD file /dwg="17HS2W1"

/dxf MicroStation/DXF file /dxf="29L107"

lad Ladder rung
/lad="EVAMTR" /rung=48 (Note: You can
specify a particular rung to open to)

/batch Batch file
/batch="1010201A" /unit=2 (Note: You
can specify a particular unit)

ab AB file /ab="16207"

/rtu RTU file /rtu="10209"

/txt Text (.TXT) file /txt="Notes"

/rtf RTF file /rtf="My RTF file"

2.1.2  How to Load an M14 File

2.1.2.1  Opening a specific M14 file

To open a different M14 file follow the following steps:

Go to the File  menu and click Open.1. 
A standard Windows browse dialog box will open.2. 
Navigate to the location of the file.3. 
Click Open.4. 

2.1.2.2  Opening a recent M14 file

You are also able to navigate to the File  menu and click the Recent M14 Files  selection to pick an M14 from
the last twelve files that were viewed.

The name of the last viewed M14 file is now stored in the registry. When Hyperview is run from the Start
button, it will be loaded with the last M14 viewed. Hyperview also stores the names of the last twelve viewed
M14s and lists them in the Recent M14 Files  option under the File  menu. This allows for quick navigation
between recently viewed M14 documents.

2.1.2.3  Opening the most recently built M14 file

Shortcuts to Hyperview can specify a wildcard M14 file specification (i.e., containing *). Hyperview opens the
newest file that matches the wildcard specification. The advantage of using wildcards like this is that you do
not have to rework your shortcuts with each new build and you can use the automatic renaming technique in
BuildPlus to archive your built M14s.

2.1.2.4  Associating M14 files with Hyperview in Windows

To make Hyperview open when you double-click an M14 file, you can associate the M14 file type with
Hyperview in Windows by following the steps below:
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Go to the Start  menu, click on Control Panel , locate the Folder Options  icon and double-click on it.1. 
Once the Folder Options  window is open click on the File Types  tab.2. 
Click the New button below the Registered File Types.3. 
In the File Extension  box enter M14 as the File Type.4. 
Once it is added click the Change  button below the File Types  box.5. 
Choose the select the program to open the file from a list selection.6. 
Browse to C:\Program Files\GMCL\DBDOC\Programs  and select hyperview_winsock.exe  as the
program to open the file.

7. 

2.1.3  Help and Documentation

2.1.3.1  How to access the built-in help documentation

The Contents , Index , or Search for Help  on the Hyperview Help menu will launch the DBDOC compiled
help. Selecting any one of these will launch the DBDOC compiled help, opened on the appropriately named
tab. The help file contains information on how to use BuildPlus, Hyperview, and CIUMon, appendices on
other programs and components, and our FAQ (Frequently Asked Questions) with useful information about
builds, set-ups or other problems you may encounter.

2.1.3.2  Help and tutorials on the GMCL website

Go to GMCL website  on the Hyperview Help menu will launch Internet Explorer and take you to the Help
page on the GMCL website. There you can access all the same information as in the built-in help, as well as
interactive tutorials, user guides, and other documentation.

2.1.3.3  How to use the What's This feature

What's This?  on the Hyperview Help menu can be used to show a brief description of any toolbar button or
menu option.

2.1.3.4  Finding the version of Hyperlink that built the current M14

Current M14 File Revision  on the Hyperview Help menu will bring up a dialog box that contains information
about the current M14 being viewed - the version of hyperlink that was used to build it and when it was last
built.

2.1.3.5  Figuring out what version of Hyperview is running

About  on the Hyperview Help menu contains the following information about the version of Hyperview
currently running:

Hyperview version· 
DBDOC Kit Version· 
Winsock / No Winsock· 
Last compiled date (of Hyperview)· 
Hyperview build revision· 
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2.1.3.6  Other ways of getting help

You may also click on various items to get more information. If it is a dialog box that you need more
information on, use the associated contextual help. Click the Help button in the upper right hand corner of
the dialog box and then click on the desired item to see a description.

12



2.2  Guide to basic navigation in Hyperview

2.2.1  Panes in Hyperview

The Hyperview browser shows two panes, or display areas. The pane on the left (or top) is called the index,
or Table of Contents  pane. It is used for indexes and summaries of information. The pane on the right (or
bottom) is called the content, or topic pane. It is generally used to display documents and graphics, although
certain types of indexes and reports can also be displayed there.

2.2.1.1  Specifying the pane orientation

You can set Hyperview up so that the index pane can be located at the left or top while the content pane will
be located on the right or bottom respectively.

To change the orientation of Hyperview, click one of the following buttons in the toolbar:

They will produce the following results:

You can use the following menu options or commands to change the view from a menu or shortcut
key:

Select Change Pane Orientation  from the View menu.· 
Select the View from the drop down list on the View tab in Options .· 
Position the cursor on the border until it becomes the split cursor and drag the cursor to the view that
you would like.

· 

Press J on the keyboard or select Split Adjust  from the View menu to get the split cursor.· 
Adjust the view to full screen by pressing F on the keyboard, selecting Full Screen  from the View
menu or double-clicking the border between the two panels.

· 

Drag the borders between the index and content panes until the index pane disappears.· 

Your viewing preferences are stored so that each time Hyperview is launched it will open to your last used
settings.

The settings it saves are:

Size of the Hyperview window· 
Position of the window· 
Size of index and content panes· 
Classic or Treeview Table of Contents· 

13



2.2.2  Index pane

When you first start Hyperview, the index pane provides a view of the Table of Contents , a summary of all
the content contained in your M14 file.

2.2.2.1  Displaying the Table of Contents

To display the general Table of Contents:

Click the Table of Contents toolbar button · 
OR press T· 
OR on the Go menu, click Table of Contents .· 

2.2.2.2  Switching between Classic and Treeview Table of Contents

There are two ways of displaying the Table of Contents . The first view is Classic View . It provides a
detailed view of your build content, but you generally have to scroll down a long way to get to what you want.
Treeview  is a compressed, collapsible/expandable, easy-to-use overview, similar to Windows Explorer.

To switch between views for the Table of Contents:

Press CTRL + T.· 
OR on the View menu, click Table of Contents as Tree .· 

To collapse the open nodes in the tree view table of contents:

Press T .· 

OR click the Table of contents  toolbar button .· 

The following are examples of the the Classic  (left) and Treeview  (right) table of contents.

2.2.2.3  Clicking on hotspots in the index pane

Some of the items in the index pane are hotspots, or hyperlinks (indicated in blue). In general, clicking on a
name-of-document hotspot in the Table of Contents  causes that document to be displayed in the content
pane below or on the right. The exception is when the item in the index pane is the name of another index.
Clicking on a name-of-index hotspot in the Table of Contents  will cause the new index to be loaded into the
index pane. Hyperview indexes will be discussed in more detail later.

Rarely, the hotspot in the index pane is a link to an external document, i.e. one that is not built into the M14
file. When this is the case, a "proxy" document (with a title and link to the "real" document) is displayed in the
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content pane. Clicking on the link in the proxy document causes the external document (e.g. a PDF file with
function code documentation) to be opened in your default PDF viewer application.

2.2.2.4  Index navigation

Go to Next/Previous Topic
Go to the next/previous topic in the browse sequence.¨ 
This is dependent on which side the focus is on.¨ 
Use B and Shift-B  on the keyboard or select from the Go menu.¨ 

· 

Go to Next/Previous Index link
In an index, go to the next/previous hyperlink in sequence.¨ 
Use L and Shift-L  on the keyboard or select from the Go menu.¨ 

· 

2.2.3  Content pane

The content pane is where documents such as Operator Graphics, CAD/CLD diagrams, reports, text
documents, Tag and Trend Database entries, and other resources are displayed. These documents
generally contain hotspots, or hyperlinks. Clicking on different sorts of hotspots will have different effects in
the Hyperview browser, depending on the type of hotspot. Some link directly to other documents, while
others represent blocks and allow signal tracing.

2.2.3.1  Displaying hotspots

There are typically many hotspots on a document in the content pane. When you move the mouse over a
hotspot, the cursor will change to a "pointing finger" shape. You can also highlight all the hotspots on a page
by pressing CTRL+TAB  or selecting Hotspots  on the Highlight  menu. You can also hover over a hotspot to
see a brief description in a tooltip.

2.2.3.2  Clicking on a hotspot to see all the uses of a value

Many hotspots represent a block or tag value. Clicking on a block or tag hotspot will cause all the places the
block or tag is used to be displayed in the index pane.
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Clicking on the value on the right brought up all the places in the system that that block is used, both as a tag
name and as a block. In this example, the selected block appears in the tag definition, on two CAD/CLD
configuration sheets, in text documentation, in this graphic, and on an AutoCAD drawing. All this information
is right in front of you.

2.2.4  Focus for the active window

Focus is shown by the color border on the index or content pane and shows which side of the browser you

are working in. It affects printing and the Next Topic  and Previous Topic  buttons. To set focus in a
particular pane, click the mouse on some white space (where the cursor remains an arrow) in that pane.

2.2.5  Setting a "Home Page" for your index and content panes

You can specify home pages for your index and content panes. If none are specified, then the Home button
will return you to the classic opening view.

2.2.5.1  Setting a "Home Page" using the Options dialog

You can set your home pages to any document in the system by selecting the Home Button  tab under
Options...  in Hyperview.

Lists all documents in the M14 that can be either specified for the index (Table of Contents) or content
(Topic) pane.

Those that can be set in the index pane are shown with this icon: · 

Those that can be set in the content pane are shown using this icon: · 
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2.2.5.2  Setting your "Home Page" to the current document

You can easily set your homepage to a topic that is currently displayed in the Hyperview browser.

Right-click on a document. In the popup menu that appears, you can easily set the index (left or top)
pane, content (right or bottom) pane or both panes to call up the desired pages. You can choose
these from the Set My Home Page  option:

Set Left Pane Only¨ 
Set Right Pane Only¨ 

· 

 Note:  The terms Left and Right will change to Upper and Lower if your viewing mode is top and bottom. In
full screen mode, you will see the terms Table of Contents Pane and Topic Pane.

Your home pages are saved in your user logon (in the same location as your annotation, bookmark and
history files). They will stay intact when the M14 files are updated. Typical content pane home pages are
overview graphics that get you anywhere in the plant in one click.

2.2.6  Scrolling

If your mouse is equipped with a scroll wheel, you can use this to scroll around in the index and content
panes (depending on which one has focus) instead of clicking on the scroll bar. In addition to being able to
scroll up and down in a pane, if you hold down the CTRL key in conjunction with using the scroll wheel, you
can scroll left (wheel up) and right (wheel down).
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2.2.7  Zooming

2.2.7.1  Zooming with the mouse

Click and drag a rectangle in the content pane around the area that you want enlarged. When you have
finished dragging, Hyperview will centre your selection in the pane, magnified to fit.

2.2.7.2  Zooming with toolbar buttons or the keyboard

To zoom in to double the zoom level, click the Zoom In  button  or press +· 

To zoom out to half the zoom level, click the Zoom Out  button  or press -· 

To toggle between full view and the previous zoom level, click the Zoom Toggle  button  or press
Z

· 

Zoom functions are also available through the View menu.· 

2.2.7.3  Manually setting the magnification factor

You can manually set the magnification factor for any graphical topic (graphic, CAD/CLD sheet and AutoCAD
drawing).

Right click on the drawing and select Set Zoom Factor  from the popup menu.· 
Enter the zoom factor you wish to apply to the topic.· 
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2.2.8  Using browser history to return to previously viewed documents

Hyperview history is similar to that of other browsers like Internet Explorer.

Going backward and forward in the browser history:

Click the Go Back  button  or Go Forward  button  to go to· 

the previous or next item.

Activate the drop down menu for the forward and backward lists by clicking on the arrow to the right
of the button and selecting the desired item.

· 

The last document viewed is retained across builds. This is stored in <project_name>.hst in the
same location as your annotation, bookmark and home page files.

· 

2.2.9  Using bookmarks for quick access to pages of interest

Flag special pages for quick access! These can be added to any document.

To bookmark a topic:

Click on the Add Bookmark  button on the toolbar.· 
OR Choose Define  under the Bookmark  menu· 

OR Press CTRL+D to quickly add the document. This option will add the document to the bookmark
list without bringing up the Add Bookmark  dialog where you can edit how the text will read in the list.

· 

Multiple bookmarks with the same name are not allowed. If you try to define a bookmark with a name that
already exists, Hyperview will bring up a message box to warn you of the duplication. It will give you the
option of editing the current bookmark name or canceling the operation.

Using and managing bookmarks:
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2.3  Techniques for tracing inputs and outputs throughout your
system

2.3.1  Overview of signal tracing in Hyperview

There are two basic ways to trace signals in Hyperview:

You can click on hotspots in in the content pane in order to display uses of the hotspot value in the
index pane. Clicking on a use in the index pane causes the document with the use in it to be
displayed in the content pane. This method of signal tracing requires that the index pane be visible,
so it cannot be used when the browser is in "full screen" mode. On the other hand, the list of uses of
a value is displayed in the index pane until you change it, and this list can be printed and perused at
leisure.

1. 

You can double-click or use the context menu on hotspots to jump directly to the source of a value
(bypassing the index pane), or to display a list of uses in the context menu that you can select from.
This method of signal tracing can be used even when the browser is in "full screen" mode with the
index pane not visible. The downside is that the index of uses of a value is only temporarily visible.

2. 

2.3.2  Tracing signals using hotspots and the index pane

2.3.2.1  Tracing back to the source of a value

To trace a signal, use the follow steps and refer to the image below:

Click on an item of interest in the right side content pane1. 
Click on item labeled source, in red in the index pane, if it exists, then click on an input to the block
newly highlighted in the Content pane

2. 

Repeat until you have traced back far enough.3. 
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Viewing live data on the fly:

At any point, you can turn on live monitoring to check what the values are.· 

If you use Slow Mode , monitoring will stay on from document to document, and values will be
fetched whenever you change documents.

· 

In Continuous Mode  monitoring, monitoring is automatically turned off when you go to another
document.

· 

2.3.2.2  Finding and displaying the uses of a value

Simply click on any tag or block in either the content pane or the index pane. Its source and uses will be
displayed in the index pane. The source is always displayed in red. By default all uses are displayed in blue.

2.3.3  Tracing signals using Go To Use, Go To Source, and double-clicking on
hotspots

2.3.3.1  Jumping directly to the source of a value with Go To Source or double-click

The Go To Source  feature is a powerful and natural feature that allows you to find the source of an value
without using the index pane at all.

There are two ways to use Go To Source:

Double-click on an input on a CAD/CLD or block on a graphic· 
OR Right-click on a point and choose Go To Source  on the popup menu· 

Hyperview will automatically take you to the source of the input.

2.3.3.2  Jumping directly to a use of a value with "Go To Use" or double-click

To access any use of a block, right-click on the block©s output or input and point to Go to Use , then click on
one of the block©s uses. If you have recently navigated to the block using Go To Source , the block from
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2.4  Full text, database, or title searches and search result navigation,
and finding coordinates

2.4.1  Overview of Searching

When you build an M14 file with DBDOC, Hyperview can search it to find almost anything.There are three
search options that you can use to find the information that you need:

 Full Text Search

 Database Search

 Search all Titles

Just look for the Big Binoculars  and move your mouse over them. The button will change to reflect the
last type of search that you did. Click on the button and the Search  dialog will open to that particular type of
search.

2.4.2  Text and database searches

2.4.2.1  Searching all the text in your system for a specific word or phrase

Search for any word or phrase throughout the full M14 document or restrict it to certain types of documents.
To launch the Full Text Search utility, you can:

Click the Search  toolbar button , then click the Full Text Search  tab· 
OR Select Full Text Search  from the Search menu· 
OR Press CTRL+F on the keyboard· 
OR Select text in a document and right-click. Go to the Search For Selection  option from the popup
menu that appears and choose Full Text Search .

· 

24



Match each term + exactly:  searches for condenser  AND pump· 
Match each term + to the beginning of a word:  searches for condenser*  AND pump*· 
Match each term + to the end of a word:  searches for *condenser  AND *pump· 
Match each term + to any part of a word:  searches for *condenser*  AND *pump*· 

 Note:  The more wildcarding there is, the slower the search will be.

In Match each term  mode, you can specify whether you wish search for ALL  the terms, or ANY of the terms
by selecting either

Find any search term· 
OR Find all search terms .· 

 Note:  The words And , Or, Not  and Near cannot be used in searching as they are interpreted as
operators.

2.4.2.2  Searching the database for particular blocks or tags

A database search allows you to search the databases built into your project. To launch the Database
Search  utility you can:

Click  or  on the toolbar and select the Database Search  tab· 
OR Select Database Search  from the Search  menu· 
OR Press ALT+D on the keyboard· 
OR Select text in a document and right-click. Go to the Search for Selection  option from the popup
menu that appears and choose Database Search .

· 
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You can search by entering the tag index value, trend index value, tag name (or partial tag name) or any
combination of Loop, PCU, Module and Block number. You can select any previously entered tag names or
miscellaneous text from the drop down list. Miscellaneous text is very useful if you know part of the
description field of what you are looking for but none of the above information.

2.4.2.3  Setting search options for text and database searches

For both Full Text Search  and Database Search :

Show Search Hit Frequency  shows you the number of times that your search item has shown up in
one document.

· 

Show Group  shows you the category to which your hit document belongs.· 
Clear Search Hits  on the Search  menu will remove all the highlight marks from the search results.· 
Limit the maximum number of search hits displayed  in each individual dialog box or set it on the
View tab in the Options+  dialog.

· 
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2.4.2.4  Viewing search results for text and database searches

After you do a text or database search, you will see the following search results dialog:

File:  Gives you the option to Save the search results to a file (a default filename is automatically
supplied.)

· 

Topics Containing Search Key:  Lists all the topics that met the search criteria. The list can be
sorted based on Topic Title, group or hit frequency. You can jump to a topic by double-clicking on it.

· 

Keep Open:  Keep the dialog box open after going to a document rather than automatically closing.· 
Show All:  If you have limited the number of search results to be displayed then you can press this
button to display them all. This button will only be enabled if there are more search results to be
shown.

· 

Search Again:  Click to bring up the full text search dialog with all your previously specified search
criteria filled in to narrow down your search hits.

· 

Go To:  Go to the currently selected topic in the list.· 
Print:  Print the search results.· 

2.4.2.5  Displaying and stepping through search results using the Hyperview toolbar

There are a number of ways you can browse search results later, even after the Search Results  dialog has
been closed.
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Use the Next Highlight  and Previous Highlight  toolbar buttons to step through the search
results in the document you are looking at.

· 

Click the Search Results  toolbar button to bring up the list of search results· 

Use the Next Search Hit  and Previous Search Hit  toolbar buttons to step through the
documents that were found.

· 

If no search hits were found, Hyperview will bring up an informational message box to let you know.

You can again choose to suppress this dialog from appearing the next time no matches are found by
checking the Don©t show me this again  option before dismissing the option.

 Note:  If you click the box, when you search for something that is not found, you will simply see the search
box remain as you launched it when the hourglass disappears. You can then easily try the search in a
different way, but you have to realize that the search was done, but was unsuccessful.

2.4.3  Using the fast topic title search

This highly convenient search mode makes it very quick and easy to jump to a topic of interest. Simply start
typing the topic name. You will see a list of possible topics as you type. The more you type, the shorter the
list will get. Double-click on one of the results any time to display it in the browser.
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2.4.4  Finding a Coordinate

You can also enter a coordinate set to go to on a specific document - a helpful feature for finding messages
reported in the DBDOC.ERR files.

Spot the blinking red ball! Find the coordinates you are interested in on a given document easily without
having to scroll through it. Hyperview will go directly to the coordinates entered and zoom in.

Three ways to bring up the coordinate locator:

Through the Search All Titles search - Enter the title and the coordinate set desired (as discussed
previously in the Searching section).

· 

OR Select Find Coordinate  under the Go menu option - enter the coordinate set that you want to go
to on the current document.

· 

OR Right-click on the drawing to bring up the popup menu and select Find Coordinate .· 

When launched via the Go menu or the popup menu, the coordinate locator dialog displays the minimum and
maximum x and y values on the current drawing. The minimum values or the last entered coordinate set are
automatically filled into the edit boxes.

A message will appear when you enter a value that is out of range. Negative values are accepted where
applicable.

Cancel the coordinate locator by double-clicking on it.
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2.5  Guide to Live Data on Documents

2.5.1  Live Data Monitoring

Hyperview provides read-only access to limited amounts of live data. Hyperview will display the data for
individual blocks as well as displaying analogue values in bar graphs where called for on graphics.

There are three ways to fetch live data from your system:

 Slow Mode (Camera)  - preferred in general· 

 Continuous Mode (Clock)· 

 Live Loop Annotations  - live data for individual points· 

2.5.1.1  Using Slow Mode live data

To take a snapshot of the live data for all the outputs in the viewing area, click on the Slow Mode button 
on the toolbar. Hyperview will fetch the values of the outputs displayed. Click the camera button again to
fetch the live data values on the display again.

Slow Mode will remain on until it is turned off by double-clicking the Slow Mode Button.· 
When you view different document, the values for it will be fetched automatically for you.· 
If you scroll or zoom on the current document, Hyperview will automatically refresh the values.· 
If you do not scroll, zoom, or change documents, Hyperview will refresh the values every ten
seconds.

· 

The shortcut keys used for Slow Mode are listed below:

M - Turns on Slow Mode and will fetch all values on the CAD sheet you are viewing. Pressing M
successively will refetch the data on the sheet you are viewing.

· 

Shift+M  - Turns off Slow Mode.· 
F5 - Refetches the values on the CAD sheet you are viewing.· 

2.5.1.2  Getting live data in Continuous mode

You can activate Continuous mode  live monitoring of your system by clicking on the Live Loop Display

button  or selecting the option from under the View menu.

Hyperview will send out requests at the desired frequency (by default, every second) for data for all
visible points in the drawing pane.

· 

The update interval can be changed in the Options  dialog.· 

 Note: On dynamic bar graphs:  The color of the bar displayed will indicate the status of the data. The
colors of the status bar are as follows:

Valid:  bar will be green.· 
Stale or unavailable:  the bar will be drawn in red crosshatch.· 
Bad quality:  bar shown in the user specified bad quality color.· 

 Note:  If you attempt to monitor without having any live loop settings entered, Hyperview will automatically
alert you and give you the opportunity to enter settings at that point. This helps to take the guess work out of
why you would not be seeing live data!
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2.5.1.3  Managing the Slow Mode Data Load

In Slow Mode , data is fetched automatically every ten seconds, and when you move the screen, zoom, or go
to another document, or explicitly refresh the values, providing an excellent balance between having the
most relevant up-to-date data, and not overloading the data bandwidth available. For most purposes, Slow
Mode will be the best option for minimizing data load due to on-document live data.

Slow Mode tips:

Double-click the camera button to turn off Slow Mode . Slow Mode  is never turned off automatically.· 
On graphics, zoom in to the area you are interested in. Data is only fetched for visible points. If you
do not zoom in, it may take Hyperview several seconds to fetch data for the entire graphic.

· 

Switch to CAD / CLD sheets sooner rather than later. This will further reduce the amount of data
fetched.

· 

If you use Slow Mode, you will leave a lot more bandwidth for other Hyperview users.

2.5.2  Live Loop Annotations

Live Loop Annotations  are "sticky notes" displaying live data. You can add them to any document. You can
create a Live Loop Annotation  to display live data or specs for any block in your system, or module status
for any module. Live Loop Annotations  are a convenient way to monitor block values, specs, or module
status for one part of your system while looking at a different part of the system in Hyperview, or to display
live data for just a few items on a document.

You can place Live Loop Annotations  on any document that you can view in Hyperview's content pane,
including graphics, text files, and database entries. If you want to monitor live data independently of what
document you happen to be viewing, consider using the Watch Window  instead.

Live Loop Annotations  are automatically saved, and will reappear on the documents where you created
them the next time you open Hyperview, even if you switch to a new build of your system. So if you always
need to refer to a certain block value while viewing a particular document in Hyperview, Live Loop
Annotations  will let you do just that.

Standard live loop annotation:
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To view help on Live Loop Annotations , right-click any Live Loop Annotation , then click Help.

2.5.3  Creating a Live Loop Annotation

The Live Loop Annotation  dialog is used to specify a value to monitor and to set or change the options for a
Live Loop Annotation .
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In the search results list, click the tag name which you wish to monitor.3. 

To monitor the status of a module:

Click Module Status .1. 
Enter the appropriate information in the LPM boxes.2. 

2.5.3.1  Block Options (for either Live Loop Annotations or Watch Window Blocks)

2.5.3.1.1  Basic Options

Description:  This text will be displayed when the mouse is hovering over a live loop annotation.· 
Update Interval:  The amount of time, in seconds, that the live loop annotation will display each
value before fetching a new value. The default interval for new annotations is one second. This
default can be changed in the View tab of the Options  dialog (see p.58).

· 

2.5.3.1.2  Annotation Options

Show Live Data:  If this is selected, the live loop annotation will show the current output value of the
block as a number.

· 

Dynamic Bar:  If this is selected, the live loop annotation will show the current output value of the
block as a bar graph and as a number.

· 

Show Live Specs:  If this is selected, the live loop annotation will show the specs associated with the
block it is monitoring. It will not show the current output value of the block.

· 
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2.5.3.1.3  Watch Window Options

Reverse Y-Axis:  Reverse the vertical axis for the plot.· 
Color:  Change the plot line color for the selected block.· 
Schedule:  Set an automatic data collection timeout for the specified block. Blocks can be manually
paused and restarted, as before, but starting in version 10.4.1 automatic timeouts can also be set. A
block can be configured to automatically stop collecting data after a certain interval, for example 24
hours, or at a specified time.

· 

2.5.3.1.4  Plot or Dynamic Bar Range

Built-In Range:  This option is only available if Dynamic Bar  is selected and the block has minimum
and maximum values specified in one of the project databases. If this option is selected, the
minimum and maximum values from the database will be used for the limits of the bar graph.

· 

Auto Range:  This option is only available if Dynamic Bar  is selected. If this option is selected, the
bar graph limits will adapt to the data fetched.

· 

Specify Range:  This option is only available if Dynamic Bar  is selected.. If this option is selected,
the bar graph will have the limits you specify here.

· 

2.5.3.2  Reading Live Loop Annotations

You may see the following symbols and abbreviations on live loop annotations:

Successful data fetch

Error

Bad quality

Alarm

Info - the version of CIUMon that you are currently using to monitor with has been configured for a
certain loop and PCU and the point that you are requesting data for does not match that
configuration.

The IP address of the computer you are currently monitoring from has not been approved by
CIUMon to fetch live data. You will also see IP_BLOCKED  displayed in the manual live loop data
window..

H High

L Low

D Deviation

C Calibration

S Service

If the symbols on an LLA are greyish, this indicates that the data is stale.

2.5.3.3  Managing Live Loop Annotations

You can view a complete listing of all live loop annotations by:

Clicking the Manage Annotations  button on the toolbar· 
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ORSelecting Manage Annotation  from under the View menu and clicking the Live Loop
Annotations  tab.

· 

For a selected annotation, you can:

Change what value it is monitoring.· 
Change any of the options, including Mouse-over text , Update Interval , and Dynamic Bar  settings.· 

2.5.3.4  Moving Live Loop Annotations

To temporarily move a live loop annotation, click and drag it to a new position. It will be linked to its
permanent position by a thin line, or "rubberband". If the annotation was created on a hotspot, the
rubberband is useful as a pointer to that hotspot.

To move an annotation back to its permanent position, double-click it.

To minimize a live loop annotation, click the Minimize  button  on its upper right hand corner.

To permanently move a live loop annotation, minimize it, then click and drag the minimized annotation to a
new position.
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2.5.3.5  Deleting Live Loop Annotations

To delete a live loop annotation from the content pane:

Click the Delete button  on the live loop annotation#8217s upper right hand corner.· 
OR Right-click the live loop annotation, then click Delete Live Loop Annotation .· 

To delete live loop annotations using the annotation manager:

To delete a single live loop annotation, select it in the list of annotations, then click Delete.· 
To delete all live loop annotations on a topic, select the topic in the list of annotations, then click
Delete.

· 

To delete all live loop annotations in the entire M14 file, select the top entry in the list of annotations,
then click Delete.

· 
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2.6  Trending Live Data in the Watch Window

2.6.1  Watch Window Overview

The Watch Window allows you to plot live data from one or more points in the same window. It helps
troubleshoot problems and analyze the way the system works. Add blocks from anywhere in the system to a
window that displays their values in an easy to use plot. Control the range, resolution and data collection rate
of each block.

2.6.1.1  Using the Watch Window: quick summary

Adding a block to the Watch Window can be done effortlessly by right-clicking on a block and
selecting Add this Block to the Watch Window .

· 

Once a block has been added to the Watch Window, it will begin collecting data. As you move the
mouse over the plot, crosshairs appear showing you exact data values.

· 

Click on the plot to place a Timestamp  showing the value and time of a point of interest.· 
Blocks are added in Split Plot  mode with AutoScaling  enabled. This gives you a natural starting
point. One click and you display them in one plot. One click and you rescale the plot of the value.

· 

You can easily walk through Timestamps by using the Back  and Forward Navigation  buttons at the
bottom of the Watch Window.

· 

Using the Block List, you can hide the plot for a block by unchecking the checkbox on the left-hand
side. Autoscaling and pausing data collection for a block can also be enabled using the Block List.

· 

Using our simple Export Data  tool, you can export the data for the group for a selected group into a
.csv file for import into Microsoft Excel$  or other external applications.

· 
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2.6.2  Opening the Watch Window

2.6.3  Adding blocks to the Watch Window so they can be plotted

There are several ways to add a block to a group in the watch window:

On any CAD or graphic, right click on any source or output hotspot and select Add this Block to the
Watch Window . The point will be added with the default options to the watch window group you
choose.

1. 

Right click on any live loop annotation and select Add to Watch Window . The point will be added to
the watch window group you choose using any live loop annotations options you already entered.

2. 

In the Live Data Watch Window , click the Add Block  button and define the block you wish to add.3. 
In the Live Data Watch Window  menu, choose Block > Add  and define the block you wish to add.4. 
Right-click on any block in the block list and choose the Add Block  menu option.5. 
Right-click on a blank area of the block list and choose Add Block  from the menu.6. 

2.6.4  Defining and editing block plots in the Watch Window

If you are specifying a block to add to the Watch Window by block number or tagname, or editing options for
an existing block in the Watch Window, you will use the Block Live Data Options  dialog.
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To edit the options of an existing block with a plot in the Watch Window:

Double-click the block in the Block List on the right hand side of the Watch Window..· 
Right-click the block in the Block List and choose Edit .· 
Select the block in the Block List and click the Edit Block  button.· 
Select the block in the Block List and choose Block | Edit  from the menu.· 

The Edit  dialog that appears is the same as that which is discussed in the section of the User Guide on Live
Loop Annotations .

2.6.4.1  Specific Watch Window Options

The following block options are specific to Watch Window blocks.

Reverse Y-Axis:  Reverse the vertical axis for the plot.· 
Color:  Change the plot line color for the selected block.· 
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Schedule:  Set an automatic data collection timeout for the specified block. Blocks can be manually
paused and restarted, as before, but starting in version 10.4.1 automatic timeouts can also be set. A
block can be configured to automatically stop collecting data after a certain interval, for example 24
hours, or at a specified time. If you like, by checking Confirm before pausing  you can require that
Watch Window obtain confirmation before automatically pausing data collection for any block.

· 

2.6.5  Creating groups of blocks in the Watch Window

Create different groups of points to keep your watch window uncluttered. Make sure to specify a unique
name for each group that you create. Create a new group by clicking on the Add Group  button or choosing
Add  from the Group  menu in the Watch Window. This will give you an empty group to which you can start
adding the blocks that you want to monitor.

2.6.5.1  Importing a list of blocks from CIULink

If you are monitoring blocks using CIULink , you may want to transfer them to the Watch Window.

Import a taglist created in CIULink as a group. Choose the Import  option from the Group  menu or click the
Import Group  button.

You have the choice of browsing for an exported .LST file created by CIULink or choosing from the list of
CIULink taglists that are currently stored in the registry.

The group will be populated with all the points in the chosen taglist - saving you from having to enter each
point individually.

2.6.5.2  Managing groups of blocks

Manage your groups:

Through the Group  menu in the watch window.· 
With the various Group buttons available on the Watch Window toolbar.· 
By right-clicking the on the group tab name and selecting the appropriate action from the menu.· 
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2.6.6  Watch Window Highlights

Crosshairs:  As you mouse over on the plots, you will see red crosshairs appear for each block that
you are monitoring. The LPMB information and the data value will appear next to the crosshair
making for easy interpretation of the plotted value. To leave a data stamp so are able to return to a
point of interest just click the mouse. These stamps will persist as the Watch Window collects new
data. They can be deleted by clicking the X in the top right-hand corner. In addition, you are able to
move through the crosshairs by using the navigation button at the bottom of the Watch Window.

· 

Freeze Scroll:  By clicking on the Freeze Scroll  button located at the bottom left of the watch window
or dragging the horizontal scroll bar, the plot will freeze, allowing you to look at the any portion of the
data without having it continuing to scroll to the left. The background of the plot will change from
white to a light gray to indicate that the scrolling is frozen. To unfreeze the scroll, click the Freeze
Scroll  button and the plot will jump to the current time.

· 

Plot Time Scale:  You can adjust the time scale against which the plot is drawn; by default, the value
is 1.00 sec/pixel. You can expand the plot by entering in a smaller value or compress it by entering a
larger number in the Plot Time-Scale field. Enter the desired value in the field and click the Apply
button or just press Enter .

· 

Split Plot:  Split plot allows each block to be placed onto its own separate plot to be graphed
separately. If you look on the left-hand side the range of values being graphed is shown at the top
and bottom of the plots. This gives you a better view for analyzing your data.

· 

Always keep the Watch Window visible:  Under the Options  menu in the watch window, check the
Always display Watch Window on Top  option so that the window will float on top of all other
windows and will always be visible to you.

· 

Exporting Data:  You are able to select which data you wish to export from the Watch Window. By
pressing the Select Mode  button on the toolbar, it will allow you to drag the mouse pointer to select
the data you wish to extract for further analysis. Once you have made your selection, press the
Export Data  button, which will confirm your selection and export the data to a CSV file. The data in
the CSV file displays very nicely in Microsoft Excel .

· 
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Go To Source or Go To Block Map:  These options are available by right clicking on a block in the
block list. Go To Source  will take you to the CAD sheet where the block is used. Go To Block Map
will take you to that block#8217s entry on the Block Map.

· 

2.6.7  Timestamp Navigation

Timestamp Navigation  buttons make the task of navigating through timestamps much easier.

 Jump to the left-most timestamp on the plot.· 

 Jump to the previous (next left) timestamp on your plot.· 

 Jump to the currently selected timestamp.· 

 Jump to the next (next right) timestamp on your plot.· 

 Jump to the right-most timestamp on your plot.· 

2.6.8  Managing Watch Window related bandwidth, and disk usage

These topics are covered briefly here, and in more detail in the User Guide chapter Guide to Managing Live
Data Load and Increasing Live Data Bandwidth.
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This Live Data Status Bar  provides useful information regarding how many data update requests are being
made per second, how many updates are received, how much memory is being used for the Watch Window
plots, and how much disk space is being used for data log files.

2.6.8.1  Bandwidth

In general, a CIU is able to provide responses to no more than 30 requests per second. If multiple users are
sharing one CIUMon to CIU connection, they will be limited collectively by that data bandwidth.

With a bit of care, you will be able to use the full power of the Watch Window without overwhelming the
limited bandwidth available. Here are some tips to keep the Watch Window data fetch rate from being any
higher than necessary:

Tips for managing Watch Window data bandwidth:

Look at Send/s  and Recv/s  in the Live Data Status Bar  at the bottom of the main Hyperview
browser to see what data requests Hyperview is sending and receiving.

· 

If Send/s  is larger than Recv/s , data updates are not "keeping up" with requests. Consider reducing
the data load.

· 

Be aware of the data update requests being generated by the main browser window. Consider

turning off live data in the main browser or switching to Slow  mode .

· 

Be aware that the Watch Window collects data even when it is not open.· 
When you add a block to the Watch Window, it will fetch new data once every 10 seconds. If you
don't need to collect data that frequently, increase the update interval.

· 

If you don't need the data from a block, but wish to keep it defined in the Watch Window, pause data
collection for that block.

· 

2.6.8.2  Memory

Prior to DBDOC 10.4, Watch Window plot data was stored in memory. If a very large amount of data had
been collected, this could affect performance.

As of DBDOC 10.4, trend data is loaded for display on an as-needed basis. Large datasets will not cause the
general memory requirements of Hyperview to increase.
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2.6.8.3  Disk Usage

All data collected in the Watch Window is automatically logged to CSV files. Over time, these files can
become large.

Tips for managing Watch Window memory use:

Look at Data Files  in the Live Data Status Bar  at the bottom of the main Hyperview browser to see
how much disk space is being used for log files (including those not currently in the Watch Window).

· 

Deleting data from inside a plot (i.e. by selecting it and deleting it) in the Watch Window will remove it
from memory and also from the data log files .

· 

If necessary, you can delete the data log files directly. See Guide to Managing Live Data Load and
Increasing Live Data Bandwidth for details on their location.

· 

2.6.9  Importing data into other applications

The best way to use Watch Window data in other applications is to export it. It should rarely if ever be useful
to use the raw data log file directly.

How to export data:

Select the data in the Watch Window you wish to export. Data for all the visble plots in the visible
group will be exported. Hiding a plot will prevent it from being exported.

· 

Press the Export Data  toolbar button. You will be able to choose the interval size for the exported
data and the file to which the data should be saved.

· 

You will have the option of viewing the data immediately in the application associated with CSV files
on your system, typically Microsoft Excel.

· 

50



2.7  Customizing the Browser Display

2.7.1  Showing and hiding specs, attributes, and tag names

2.7.1.1  Viewing specs on CAD/CLD diagrams

On a CAD/CLD sheet, block specifications can be hidden, or viewed in two different ways - either drawn
directly on the sheet or drawn on a gray background.

To view specs:

Press S on the keyboard· 
OR Select Specs  on the View menu and choose the view you want.· 
OR Right-click on a CAD/CLD Sheet, select Specs  in the View option of the popup menu and
choose the view you want.

· 

 Note:  The key C formerly was used for this purpose, until DBDOC 10.2.

Cycle through the different displays and turn off the specs by pressing S on the keyboard.
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What if the specs are obscuring other information on your CAD/CLD sheet?

In the opaque  mode, click and drag the specs windows to different locations.· 

Some interesting features of the Specifications window:

A "rubberband" links the spec window to its original position so that it is always clear which set of
specs belongs to which block.

· 

Double-click on the spec window and it moves back to the original position at which it appeared.· 
The locations of your specs are retained between Hyperview runs so once you have moved your
spec windows to the locations that you like, they will stay there until you move them again.

· 

Live values for specs modified by Adapt Blocks is shown right next to the block they belong to.· 

2.7.1.2  Viewing tag names on SODG graphics

On a SODG graphic, the tag name will be turned on or off if you press S or A. (If you right-click for the popup
menu, you can turn on/off the Specs and choose how they are displayed in the Attributes/Tag Names
option).
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Note that graphic links (G12 above) also appear.

2.7.1.3  Viewing attributes on CAD/CLD diagrams

On a CAD/CLD sheet, DBDOC displays the tag name and tag description above a tagged,
exception-reported block. Like the specs, the attributes can be hidden, drawn directly on the sheet or drawn
on a gray background. To view attributes:

Press A on the keyboard· 
OR Select Attributes  on the View menu· 
OR Right-click to bring up the popup menu and select Attributes  from the View menu option.· 

Cycle through the different displays and turn off the attributes by pressing A on the keyboard.

2.7.2  Highlighting options in Hyperview

2.7.2.1  Highlighting search hits

Search Hits:  With this option checked, search hits are highlighted on the document and you can scroll to the
next or previous search hit. This may also be turned on via the popup menu that is brought up by a
right-click. Select Search Hits  from the Highlight  sub-menu.

2.7.2.2  Highlighting hotspots

Hotspots: Highlights  all the hyperlinks on a page. This is useful for determining the location of hyperlinks in
a textual or graphical display. You can also use the CTRL+TAB  key combination to show all the hotspots on
a page.
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2.7.2.3  Showing "Vegas Lights"

Vegas Lights:  With this option checked, a colorful marquee will appear to highlight your target. You can:

Press V on your keyboard to toggle Vegas Lights  on and off· 
You can set the interval at which the lights blink on the View tab in Options· 
Function Code Hotspots:  Check this option to enable the link from the function code number (or
AI/DI import block) to the FUNCTION CODE INDEX.

· 

2.7.3  Options Menu: Properties for Hyperview

2.7.3.1  View options

Most of the options on the View tab are fairly self-explanatory:
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Big Toolbar· 
Wrap Toolbar· 
Full Path in Title Bar· 
Magnify Text· 
Always Open in Hyperview Maximized· 
Select Pane View· 

An overview of other features available on the View tab of the Options  window:

Log meta debug commands:  Debugging feature.· 
Save History on Close:  Saves the last document viewed before Hyperview closes so that when it is
reopened, the M14 will be opened to that document. If unchecked, the M14 will open to pages
specified by the Home button.

· 

Default path to override /save location:  If the save switch was passed in via the command line
specifying a location to which files should be saved, the path entered here will override that location.

· 

Search Settings:  Previously discussed in the Searching section.· 
Vegas Lights Settings:  Specify the frequency that the Vegas Lights will flash at.· 
Annotations Text Size:  Select the size of the font for the text that appears in your text annotations.· 
Folders to Search for External Files  Specify additional folders to be searched for external files
(files not built into the M14). See Viewing external files  for more information.

· 

Reset Preferences to Default:  This will reinitialize your Hyperview settings to the standard settings
that are present when Hyperview was initially installed and run.

· 

Restore Preferences:  If the Hyperview settings have been reset to the default (standard) ones,
checking this option and then clicking the Apply  or OK button will restore the user©s custom settings
that were in use before the reset. If you have selected Reset Preferences to Default  and chosen
not to restore preferences before exiting, Hyperview will do it for you automatically.

· 

Reset to show all suppressed dialogs:  Check this option to have the No Search Results  and
Bookmark Message  dialogs appear the next time they are triggered.

· 

2.7.3.2  Color options
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Restore default annotation colors with the Reset colors to default  button.

2.7.3.3  Font substitution options
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2.8  Making Notes on Documents

2.8.1  Overview of Annotations

Annotations are like electronic sticky notes that you can attach to the majority of the documents contained
within your M14. There are two types of annotations that you can create:

Text-based Annotations:  Make comments on a document to keep track of important things to note.1. 
Live Loop Annotations:  Create a note on a document that can fetch the live data value of any
particular point in your system from anywhere in your M14.

2. 

2.8.2  Text Annotations

Annotations are notes that can be created by two methods:

Right-click on the document and select Create Annotations  from the Annotations  option on the
popup menu.

· 

Click the Create an Annotation  button  on the toolbar, and place the annotation on the desired
document.

· 

Text annotations can only be created on graphics and drawings, not on text files. Text annotations will persist
across builds of your system. If you remove a topic, it will be listed as an Invalid Topic in the Manage
Annotations  dialog box. If you add a file back into your build it will activate the annotations that were
originally on that document.

2.8.3  Managing Annotations

To move an annotation, drag and drop the annotation window or anchor point to the location you want.

If you have to make the same note in different places, you can make a copy of the original annotation and
paste it anywhere you want. On the original annotation, right click and select Copy Annotation  from the
popup menu. Navigate to where you want to paste the annotation, right-click, and choose Paste Annotation
from the Annotations  menu.
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2.9  Printing Documents and Groups of Documents

2.9.1  Printing a single document

You can print the active pane by clicking the Print  button  on the toolbar or by selecting from the various
print options under the File  menu. The pane that currently has focus will be printed.

If a dialog box appears asking you if you really want to print an index page, the answer is probably No. This
is just a safeguard in case you have accidentally left the focus on the wrong pane. If you want the content
(graphic or CAD/CLD sheet), make sure the focus is on the content (right/lower) side and print again.

Pages are printed with the drawing name, date and time and custom captions can be inserted. Our caption
feature (in Advanced Options) lets you record a useful comment for this topic that will be printed at the
bottom of the drawing.

Zooming in on a particular area gives you better resolution. A diagram will appear in the lower right hand
corner of the print out, showing the portion of the drawing being printed.

2.9.1.1  Printing options

Various options can be set for printing:
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2.9.1.2  Fast Print to use your previously defined print settings

After doing the first print, you can avoid seeing the Print  dialog box before each subsequent print by:

Selecting Fast Print  from under the File menu.1. 
Pressing P on the keyboard.2. 

 Note:  The print dialog box choices from the first print will be applied to subsequent prints.

2.9.1.3  Printing selected text

You can select a portion of any text document, including the contents of the index pane, to print. The
Selection  radio button in the print dialog box will be enabled.

2.9.2  Marking the current topic for later printing

This option is useful when a large number of topics needs to be printed at one time. You can use the easy
popup menu interface to add a document. Right-click on the document and select the Mark for Print  option
from the popup menu.

You will be presented with two options:

OR

2.9.2.1  Marking the current topic for printing

The first choice presented in the submenu is always to mark the current topic (document) for printing. The
current document will be added The document you mark for print will be added to the Marked Topics  list in
the Mark Topic for Printing  dialog.

2.9.2.2  Marking the index for a block or reference for printing

If you choose Mark for Print  in a hotspot popup menu for a block or reference hotspot, the second option
presented will be to add the index for that block or reference to the Marked Topics  list.

2.9.2.3  Marking a linked topic for printing

If you choose Mark for Print  in a hotspot popup menu for hotspot that links to another document, the second
option presented will be to add the index for that block or reference to the Marked Topics  list.

On the File  Menu, click Mark Topic For Printing... . This displays the Mark Topic for Printing  dialog.
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2.9.3  Using the Mark for Print dialog to print groups of topics

The Mark for Print  feature allows you to "mark" or select a topic or group of topics for printing. The marked
topics are stored in the Marked Topics  list shown in the Mark Topic for Printing  dialog. Once topics are in
the list, they can be printed en masse. This feature allows you to easily collect topics for printing as you are
browsing, and also to print all (or some) topics of a certain type, for example CAD sheets, BATCH files, or
topics with annotations, without having to view and select each topic individually.

2.9.3.1  Marking a group of topics for printing

In the Mark Topic for Printing  dialog,

Select All Topics in Group  from the Mark Menu.1. 
Select a group of topics from the Groups  Menu.2. 
Click Add3. 
Make sure the the desired group has been added to the Marked Topics  list box, and items to be
printed are checked off. The topic groups in the Marked Topics  list box are expandable, and
individual items can be unchecked if you do not wish to print them.

4. 

If you wish to print the topics in the Marked Topics  list now, click Print Topics .5. 

2.9.3.2  Removing topics or groups of topics from the marked topics list

In the Mark Topic for Printing  dialog,

Select the desired topic or group to remove by highlighting it in the Marked Topics  list box.1. 
Click Delete to remove the highlighted group or topic.2. 

OR

Click Delete All  to remove all items in the Marked Topics  list box.1. 
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2.9.3.3  Other options

In the Mark Topic for Printing  dialog,

Delete General Marked Topics List on Close Once Printed:  General topics shown in the Marked
Topics  list are cleared when the dialog box is closed if they have been printed.

· 

Enter/modify caption for selected topic:  Allows you to create or change a caption for the selected
topic. Use this option to include comments about the topic; the drawing title is printed automatically
above the caption.

· 

Save Topic To File:  Cicking this button will bring up the standard Windows Browse  dialog which
will allow you to specify a location in which to save the selected files in the Marked Topic  list in text
form. Once a directory has been selected, the files will be saved immediately.

· 
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2.10  Tools, Reports and Indexes

2.10.1  Viewing the resources used in a drawing with the Audit Window

You can use the Audit Window to view the resources used in a CAD/CLD or graphic. This includes:

Block and tag usage· 
Input and Output references· 
Function codes· 
Graphics / document links· 

You can open the Audit Window by either selecting it from under the View menu, from the popup menu on a

right mouse-click, or the  button on the toolbar.

Hyperview will highlight the selected target from the Audit Window and zoom in to the appropriate level. You
can save the Audit Window contents for printing or editing later.

Print them now with File  then Print· 
Select File  then Save· 
You can print or save the whole list or just the individual parts of the list, i.e. the Blocks, Tags,
References, Function Codes or Miscellaneous. There are also various formats in which the list can
be printed or saved -

· 

allowing you to get the information in a format that best suits your needs. A default name will also be
supplied.

Below is a drop-down menu for Audit Window/File/Save Options:
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Why do you want to use Audit Window?

Checklist for tags· 
All places a block is used on the CAD/CLD or graphic· 
Verify that a block is used consistently· 
See the tags on an AutoCAD or MicroStation sheet· 
On graphics, determine if the uses of a tag are spread across the page· 

2.10.2  Using PCU Map to understand interactions among PCUs

The PCU Map shows you the interaction between PCUs, listing what blocks are exported and imported
between two units. Access the PCU Map from the Miscellaneous Indices  chapter by clicking on the
PCUMap.txt  entry. Click on the PCU Report Page  link to bring up a table similar to the following:
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2.10.3  Graphical Block Map: a graphical overview of block usage

Block map is a graphical overview of block usage, showing configuration aspects and issues at a glance.
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 = (Blue Border) The block is exported, but not tagged.

 = (Black border) The block is tagged and exported.

 = (Yellow block) The block is tagged , but unused.

 = (White block and border) The block is completely unused.

Ideally, what you want to see for your blocks is: 

A green block with a black border is a "perfect tag" - tagged, exported and used. The Block Map allows you
to see where blocks are available for insertion of a large function code. The list of Used and Unused Blocks
is complementary. They consist of ranges of blocks, separated by commas, that indicate where gaps exist in
block usage. They are designed to be printed on one page for easy reference when inserting logic in a
module.

2.10.4  Tag Map: an alphabetical index of all the tags in your system

Tag Map is an overall view of all the tags in all your databases.

The Tag Map is found in the Database  chapter in the Table of Contents. It is comprised of an alphabetical
and numerical listing of all the tags in your system. Each tag database is a column and each tag is a row. If a
tag is present in a database, it will appear in the appropriate column, with its associated Loop, PCU, Module
and Block information. The LPMB information is a link that you can click on that will take you to the
corresponding Block Index page. If the tag is not present in a database, the text ABSENT will appear in the
column.
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Tips for using the Tag Map:

For quick loading, switch to Treeview Table of Contents  mode (press Ctrl+ T ).· 
When you click on a Block Index link, it will highlight the first reference to that block, not the one that
you clicked on.

· 

The database column headers are not repeated but the databases are in the same order as in the
Table of Contents (alphabetic).

· 

2.10.4.1  Using the Tag Map

To find inconsistent LPMB in your tags:

Do a Full Text Search in current topic for Exact Match for ++.· 
Inconsistent tags appear in red and are preceded by the text ++.· 
In DBDOC_TAG_MISMATCH.ERR, look for the Tag mismatch for X: see TAGMAP for details .· 

To get a list of all tags in your system:

Select and print the individual Tag Map pages.· 
If you have more than four databases, set your printer to use landscape orientation.· 

To walk through the Tag Maps:

Click on the first letter combination and page down to see all the tags in that section.· 
Type B for browse to see each section.· 

 Note:  You can also locate these graphics and symbols by looking at the UNDEFTAG.idx,
UGRAPHICS.idx and USYMBOL.idx lists located in the Miscellaneous Indices chapter of the M14.

For quick loading, switch to Tree View Table of Contents  mode (Ctrl+T  keys).· 
When you click on a Block Index link, it will highlight the first reference to that block, not the one that
you clicked on.

· 

The database column headers are not repeated but the databases are in the same order as in the
Table of Contents (alphabetic).

· 

Find inconsistent LPMB in your tags:

Do a Full Text Search  in current topic for Exact Match for ++.· 
Inconsistent tags appear in red and are preceded by the text ++.· 
In DBDOC_TAG_MISMATCH.ERR, look for the Tag mismatch for X: see TAGMAP for details .· 

Get a list of all tags in your system:

Select and print the individual Tag Map pages.· 
If you have more than four databases, set your printer to use landscape orientation.· 
Walking through the Tag Map:· 
Click on the first letter combination and page down to see all the tags in that section.· 
Type B for browse to see each section.· 
For quick loading, switch to Tree View Table of Contents  mode (Ctrl+T  keys).· 
When you click on a Block Index link, it will highlight the first reference to that block, not the one that
you clicked on.

· 

The database column headers are not repeated but the databases are in the same order as in the
Table of Contents (alphabetic).

· 
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2.10.5  Graphics Cross-Reference Window: index of all the graphics that link to and
from the graphic, plus included symbols

The Display Cross-References  option displays an index of all the graphics that link to and from the graphic
as well as symbols included in the graphic. This tool also shows symbols individually and any graphics that
include the symbol. The CROSS REFERENCE INDEX page for a particular graphic provides information
similar to the Audit Window except across the whole DBDOC system. When building your project, in the
BuildPlus Project Options , choose the Advanced Options  on the Processing Options  page and make
sure the Exclude Symbols and Submodels  chapters from build is unchecked to get full symbol cross
references.

Accessing the Cross Reference Window while on a graphic:

Click the Display Cross References  button · 
Under the Go menu select Display Cross References· 
Type X on your keyboard· 

A separate floating window will be opened showing you the different Graphics Cross References categories,
handily displayed in a tree view:

The position and size of the Cross Reference Window will be retained between runs so that you do not need
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to reset them to suit your preferences each time the feature is used. The window will remain open while you
navigate to different documents in your M14 until you choose to close it or open up a different M14 file.

You can always return to the original graphic referenced in the Cross Reference Window if you have moved
onto different documents by clicking on the "(click here to return)" link at the top of the tree.

This feature can be used to cross-check a number of things in your system:

Find out which user symbols are no longer used by your graphics· 
Step through your symbol chapters· 
Bring up the cross-references for each symbol· 
Symbols that are never used will have a blank cross-reference page· 
Locate graphics not being built but are still being linked to· 
Step through your graphics chapters· 
Bring up the cross-references for each graphic· 
Black entries (no hotspot) in the CROSS REFERENCE INDEX indicate that DBDOC was unable to
build the graphics called for; either the build was incomplete or some of the graphics are trying to link
to graphics that no longer exist

· 

2.10.6  FUNCTION CODE INDEX: a list of every instance of each function code in
your system

The FUNCTION CODE INDEX is located in the Table of Contents under MISCELLANEOUS INDICES. It lists
and links every instance of each function code in your INFI 90 system. Starting with Version 9.60, the link
from the function code number (in parentheses) to the FUNCTION CODE INDEX will be disabled by default.
In the disabled state, only the function code help will work, but clicking on the function code number will not
take you to the FUNCTION CODE INDEX entry. In the enabled state, the link will be there as it has been.
The new feature is to make it harder for inexperienced users to get lost.

Function Code Hotspotting can be turned on or off via the Function Code Hotspots  option in the Highlight
menu. You can also turn on the option by left clicking on a function code hotspot position that will bring up
the following dialog:

You can choose to:

Enable the hotspots· 
Disable the message box from appearing again the next time you click on a function code hotspot
position

· 

Do nothing at all by clicking OK without checking either option or clicking the Cancel  button· 
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2.10.7  Graph of F(x) (Function Code 1)

INFI 90 Function Code 1 implements user-specified piece-wise linear functions. Hyperview displays a sketch
of the function in the function box when specs are visible (hint: use the S key). Right-click on the block
number and select Show Live Function Graph for this Block  to get a larger, resizable, movable graph.
Example of a Function Code 1 Graph:

You can open all Function Code 1 graphs on a sheet by right-clicking anywhere and selecting Live F(x)
Graphs | Show All  from the popup menu. You can close them all by selecting Close All  from the same

menu. You can print any particular graph by clicking on the print button  in the lower right hand corner.
The graph will be printed full-page size.

The graph plots the spec values that define an input-output function. In version 10.4 and newer, the input and
output values are also plotted directly on the graph, and are updated at the same rate as the underlying
document. You can force a data refresh by clicking the refresh button in the graph window.

2.10.8  Adapt Block

Follow the link for Function Code 24 from the FUNCTION CODE INDEX to all the instances of Adapt Blocks
in your INFI 90 system. You can easily go from the Adapt Block to the block it adapts (or the other way
around), even if they are on different pages. Live monitoring will show the adapted spec in grey on an adapt
block. Adapted specs are further marked with a right angle bracket beside the spec (>).

78



2.10.9  Rung Block Display

Rung blocks are heavily used in some systems: turbine control systems designed by ETSI, for example.
When specs are visible, Hyperview displays a ladder diagram that describes the function of the rung block.
Live monitoring will show which inputs are open and closed, plus the output.

Forced outputs are shown in Version 9.60 and later.
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Hyperview will display 0, 1, H or ? in a red box after the output.

2.10.10  AutoCAD and MicroStation

AutoCAD and MicroStation drawings are useful to have in the DBDOC build. Viewing them in Hyperview is
much easier than working with large stacks of sheets. Where the INFI 90 tag name is on the drawing or can
be constructed from data in attributes, there will be a direct link to the tag in the CAD/CLD sheet and on
graphics. Live information can be displayed on these drawings. Links are also constructed based on a partial
text phrase match algorithm that can be activated in the BuildPlus Project Options. We can customize the
way we identify tags so if you are not getting the links you want, please contact us.
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2.11  Managing Live Loop Connections

2.11.1  About live data settings

Live data can be displayed on documents in Hyperview and plotted in the Watch Window. This data must be
fetched from your system, generally from a CIU. A DBDOC data server called CIUMon talks to both
Hyperview and the CIU, and transmits data requests and responses.

Different systems have different configurations for live data. Some have one CIU, and some many. Some
have serial port modules available. Some have CIUMon servers running in relay mode located on an
intermediate LAN to provide NERC compliant live data to the Business LAN.

Hyperview needs to know what data servers to talk to. Generally this is specified right in the M14 file (built by
BuildPlus during the build process). The live data connections can also be specified from inside Hyperview.

Your live data settings have probably already been configured, built into the M14 file. If no settings are built
into your M14, or you need to change or override the built in settings, you can create custom settings in the
Live Loop Settings  tab in the Options  dialog.

2.11.2  About the Live Loop Setup dialog

Live Loop Setup dialog
The Live Loop Setup  dialog is the control center for managing and monitoring your live loop setup. This is
where you can see what CIUMons Hyperview is connected to and whether there are any connection issues.
Although the current version of Hyperview automatically routes data requests to be best placed CIUMon, it is
also possible to force requests for particular loops or PCUs to be sent to a specified CIUMOn. If a serial port
module is available for a particular PCU it will be used automatically for requests for that PCU.

In general, your live loop configuration will be determined by your DBDOC administrator and built into your
M14 file. If this configuration has not been defined in this way, or you wish to override it, you can create a
custom live loop configuration in this dialog which can include CIUMons of your choice, or force certain
CIUMons to be "ignored" by Hyperview.

 Note:  You can see an icon representing the status of your live loop connections in the Live Data Status
Bar .

2.11.3  Choosing a settings list
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Live loop configuration is handled a bit differently from before starting with Hyperview 10.4. As before,
settings can be built directly into the M14 file by your DBDOC administrator, but now it is possible to group
the CIUMons into different lists based on what network context the the CIUMon is located in. For example,
many sites have one or more CIUMons running on their DCS LAN which are accessible to Hyperviews on the
DCS LAN, but not accessible to Hyperviews on the business LAN. Those sites might add a second settings
list that included a CIUMon running in relay mode on the business LAN.

You can choose among project (M14) settings, custom local settings, and demo data.

Use a CIUMon settings list from the project file

The settings lists built into the M14 can be seen in the drop-down under Use a CIUMon settings list from
the project file . Usually there will be only one list, but it is possible to build multiple lists into the M14. Your
DBDOC administrator might do this in order to specify different CIUMons to be used in different network
contexts. Hyperview will try to choose the correct list for you (based on which CIUMons it can connect to), but
you can override this choice manually.

Show demo (fake) data

Use this option to test the visual display of live data when your Hyperview is not hooked up to a CIUMon.
You would never use this option under normal circumstances.

Use custom settings

This choice allows you to define a local persistent CIUMon list. Use it if there are no settings built into the
M14, or if you want to create different settings. Pressing Reset to match M14  will re-initialize the custom
settings to match the currently selected M14 settings. If you want to create custom settings that are similar to
the M14 settings, that©s a good place to start.

2.11.4  Understanding your current live loop settings

The list of CIUMon servers that Hyperview is currently connected to (or trying to connect to) are displayed in
CIUMon Settings . If you select a different server list as described above, a different set of servers will be
displayed here. In general this list of servers will have been preconfigured at the build stage, and built into
the M14. More than one list may have been built into the M14 (typically to support fetching live data in
different network contexts). In this case Hyperview will generally have selected the appropriate list
automatically.

Each CIUMon server in the list is connected to either a CIU, a Serial Port Module, or another CIUMon server
(in relay mode) which is ultimately connected to an actual CIU or SPM.

Unlike in previous versions of Hyperview, it is not necessary to specify in Hyperview which loop a CIUMon
server is connected to. CIUMon reports its loop connection directly to Hyperview, and data requests are
routed appropriately. The self-reported CIU location is shown in this dialog.
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Location  and Port

This is the computer and port that a CIUMon server is running on. Hyperview makes a connection to the
CIUMon at that location. This is the only information about a CIUMon server that Hyperview needs to know.

Status

This column shows the current status of the CIMon connection, whether it is connected, not connected, or
blocked. If Hyperview is connected to a version 10.4 or later CIUMon, CIUMon will self-report which loop it is
connected to, and that information is displayed here. Similarly, if the CIUMon is connected to an SPM to talk
to a specific Loop and PCU, the PCU number will be shown here.

 Note:  If Hyperview is connecting to an older CIUMon (pre 10.4), that CIUMon will not self-report its CIU
location. In that case, the CIU location information can be provided manually via Routing Preferences  (see
below). When CIUMon settings are converted to version 10.4, routing preferences are automatically created
for unusual cases, and you can also create them manually if neded. This should rarely be necessary.

Local port

This column indicates which local port on the Hyperview computer is being used to make the connection with
the CIUMon server. Normally it is chosen automatically from the default port range, but it can be specified
when a connection is defined, or a non-default port-range can be specified.

Used for

This column shows which loops are having their data fetched via that CIUmon. For example, if "3" is in this
column, it means that data requests for Loop 3 are going to that particular CIUMon server.

2.11.5  Adding or modifying live loop connections

2.11.5.1  Adding a connection

To add a new live loop connection to a CIUMon server, press Add  beneath the server list. The Add CIUmon
dialog will appear. Specify the location of the CIUMon server Hyperview needs to connect to.

 Note:  You can only add, edit, and delete servers that are part of a Custom settings  server list. You can©t
change a server list that is built into the M14 project file.
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Hostname or IP

Specify the name (or IP number) the of the computer on which the CIUMon server you wish to connect to is
running.

 Note:  To indicate that the desired CIUMon is running on the local machine, use 127.0.0.1. Generally
localhost  will work as well, but this depends on your hosts  file being configured correctly.

Port

Specify the port that the CIUMon server is listening on. By default this is 5099, but if a CIUMon server on
your system has been configured to listen on a different port, you must specify that port here.

Force Hyperview to use a specific local port

Allows you to specify which port will be used locally for communications with the CIUMon server. It is usual to
leave this blank, and allow it to be selected automatically from the default port range (or specified port
range), but under some circumstances it may need to be set explicitly.

Local port

If you are forcing Hyperview to use a specific local port by checking Force Hyperview to use a specific
local port , you must specify the port number here. You might do this if your Hyperview can only use one
specific port through your firewall.

2.11.5.2  Editing a connection

To edit an existing live loop connection, select the connection in the CIUMon settings  list and press Edit .
The Edit CIUmon  dialog will appear. Make the changes needed and press OK.

2.11.5.3  Deleting a connection

To delete an existing live loop connection, select the connection in the CIUMon settings  list and press
Delete.
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2.11.5.4  Ignoring a connection

To "ignore" an existing live loop connection, select the connection in the CIUMon settings  list and press
Ignore . Functionally this is identical to deleting the connection. When routing data requests, Hyperview will
act as though that connection did not exist. However, it is temporary, because an ignored connection can be
unignored  and reinstated. If for some reason you want to force Hyperview to never send requests to a
particular server, you can "ignore" it.

2.11.6  Specifying a non-default local port range

By default, Hyperview will assign a local port to a CIUMon connect automatically, choosing an available port
from within the default port range. Unless you require specific port behavior, for example due to firewall
constraints, it is best to stick with this default.

To specify a custom local port range, check Use custom port range  and then specify the range.

 Note:  You can only specify a custom port range for a Custom settings  server list.

2.11.7  Adding routing preferences

Normally data requests are routing to appropriate servers automatically.

In the event that you want to specify that requests for a particular loop or loop-pcu combination should be
routed to a particular server, click on Routing preferences .

 Note:  If Hyperview is connected to a pre-10.4 CIUMon, the CIUMon will not self-report the location of the
CIU it is connected to. Use a routing preference to specify this location if needed. The CIUMon will otherwise
be assume to be connected to a CIU on Loop 1.

To add a routing preference, click on Routing preferences© to bring up the Add preferences  dialog.

Specify the loop (and PCU, if applicable) you wish to make a routing preference for.
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Choose the CIUMon server to which data requests for that loop-PCU should be routed.

You can also edit and delete existing routing preferences.

2.11.8  Unavailable data

If data cannot be fetched for a particular loop or PCU, the loop and PCU are displayed here. If live data
monitoring is turned on, but there is no CIUMon connection established, there will be items in this box. This
could also happen if the only CIUMon available is connected to a serial port module on a certain PCU, and
data is being requested for a different PCU.
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2.11.9  Status of live data connections

It©s easy to see the current status of your live data connections. Just look at the network icon in the
Hyperview status bar.

Connection OK (Project
Settings)

CIUMon is connected using M14 file live data settings, communications
are happening, user is not blocked

Connection OK
(Custom Settings)

CIUMon is connected using local custom settings, communications are
happening, user is not blocked

Unable to connect Cannot communicate with specified connections

No connection specified No connections have been specified in the Live Loop Setup options dialog

Connection blocked
User is not allowed to collect data on any of the specified connections --
they have been blocked by the DBDOC administrator

Demo settings Demo data is being displayed, not data from CIUMon

2.11.10  Compression of Hyperview data requests

Hyperview examines basic Loop, PCU, Module, Block (LPMB) information and combines requests
before sending it out to CIUMON.

· 

If two people are using Hyperview to monitor the same set of points, will CIUMon will only pass on
one set of requests to the CIU.

· 
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2.12  Managing Live Data Load

2.12.1  Overview of live data bandwidth limitations when fetching live system data

Until recently, the live data fetch rate available in most systems was very low, about 10-20 values per
second. DBDOC, along with other system applications, was subject to this very low data bandwidth.

DBDOC 10.4, when used with the RoviSys Turbo, changes this picture. When used in conjunction with the
RoviSys Turbo, DBDOC achieves peak data fetch rates of over 100 values per second, and routine data
rates of more than 30 values per second when fetching data continuously.

Before DBDOC 10.4, a DBDOC installation might have used a RoviSys Turbo to interface with a Composer
CIU, or to multiplex a CIUMon server with the CIU connection of an existing EWS. With DBDOC 10.4 the
RoviSys Turbo can be still be used for these purposes, but it can also be used with all CIUs (including older
ICI01 CIUs) to increase data fetch rates by a factor of five or ten.

Despite this groundbreaking improvement in live data availability, bandwidth is relatively speaking, low. You
need to be aware of the very limited live data fetch rate available in most systems, and techniques to avoid
overwhelming the limited capability as you use live data display and trending features in Hyperview. When
multiple users of Hyperview all fetch live data from the same CIU, they share the bandwidth available, so if
that is the case in your system, you need to be doubly aware.

The good news is that the extra bandwidth provided by DBDOC 10.4 and RoviSys Turbo make it much
easier to use DBDOC©s Watch Window for data trending without overwhelming capabilities of your system.

Read on for critical information about the following:

How to tell how much data is being fetched by your Hyperview browser.· 
How to manage the Watch Window data load in Hyperview.· 
How to manage the data load of live data display in Hyperview.· 

2.12.1.1  Constraints on live data fetch rate

Fast facts:

A single CIU without RoviSys Turbo gives fewer than 20 values per second to the entire world of
DBDOC.

· 

Multiple CIUs without RoviSys Turbo can give fewer than 20 values per second each.· 
A serial port module can give DBDOC as many as 80 values per second from the PCU it is serving, a
capability that very few are using.

· 

The updated RoviSys Turbo uses an optimized fetching and polling strategy, and has been clocked
at over 100 values per second in the field, and routine data rates of over 30 values per second. This
is a vast improvement, but still quite constrained.

· 

Ways to increase the bandwidth available:

Use the RoviSys Turbo in conjunction with DBDOC 10.4 in order to increase your data fetch rate by
a factor of five or ten.

· 

Multiple CIUMon processes multiplexed to each of your EWS CIUs will give you more data. Use
RoviSys Turbos to multiplex CIUMons to EWS CIUs.

· 

If you have a small number of PCUs, multiple serial port modules will give you a great deal more
data.

· 

CIU setups and how they affect available bandwidth:
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Single CIU   ± A single CIU should probably be on Ring 1, unless it cannot be, or unless the main
system is not on Loop 1. Be aware of the extra load of bridging from one loop to another, which has
to be done by way of Ring / Loop 1. If you have only one CIU available for DBDOC, you are limited to
the base 10-20 values per second, unless you also use the RoviSys Turbo to optimize data fetching.
Using this extra software will increase your data rate to 30-100 values per second.

· 

Multiple CIUs   ± You may have more than one EWS, and each might be on a different Loop. It is
easy to take advantage of DBDOC CIUMon and RoviSys Turbo. We encourage you to multiplex any
EWS CIUs you have. For 10% to 20% of the cost of a CIU, you can have its spare bandwidth
available for DBDOC. It is simple to implment and easy to reverse or suspend.

· 

Serial Port Modules   ± The Serial Port Modules are of immense value when used with DBDOC.
Each is capable of giving up to 80 values per second from the modules in a PCU. Of course, you
have to be satisfied that this does not load the PCU too much, but being on top of that is a
manageable problem. As all the data from any PCU with its own Serial Port Module is offloaded from
your CIUs, the system directly gains throughput, too.

· 

2.12.2  Managing live data load

2.12.2.1  Managing data load for live data on documents

Tips for minimizing your bandwidth needs:

Slow  mode  should be used (not Continuous  mode ) unless continuous data is necessary.· 

Be aware of the Send/s  and Recv/s  fields in the Live Data Status Bar  at the bottom of the
Hyperview browser. These indicate how many data requests Hyperview is making per second, and
how many data updates it is receiving.

· 

Be aware that unlike live data on documents, the Watch Window collects data even if it is closed or
hidden.

· 

If you use Continuous mode live data display on documents:

On documents, live data is fetched for all visible points. If you are zoomed out on a graphic, and
monitoring in Continuous  mode, this can place a heavy load on the system. Zoom in  on graphics.

· 

Better yet, avoid Continuous  mode live data on graphics  ± save it for CAD/CLD diagrams!· 
Make sure the default update interval for live loop annotations is no smaller than it needs to be. The
default update interval can be specified in the Options  menu on the Hypervew browser.

· 

Be aware that your data collection activities affect the bandwidth available to other Hyperview users
sharing the same CIU connection.

· 

2.12.2.2  Managing live data load for blocks in the Watch Window

The Watch Window is easy to use, and easy to abuse. Be aware of how much data you are asking for, and
be especially careful when the Watch Window is closed. Closing Hyperview stops data collection in the
Watch Window but when Hyperview is reopened it starts data collection again without necessarily opening
the Watch Window.

Tips for minimizing your bandwidth needs for live data collected by the Watch Window:

Don©t collect data you don©t need. Pause data collection  by clicking on the green clock  for blocks
you are not actively trending.

· 
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Be aware of the Send/s  and Recv/s  fields in the Live Data Status Bar  at the bottom of the
Hyperview browser. These indicate how many data requests Hyperview is making per second, and
how many data updates it is receiving.

· 

Be aware that the Watch Window will collect data even if it is not open.· 

The default update interval for Watch Window blocks is 10 seconds. Increase the update interval  if
you don©t need that level of detail in your data. You can change the update interval by editing this
field in the block list to the right of the plots: .

· 

2.12.3  How to tell how much data is being requested (Live Data Status Bar)

In Hyperview you are now able to tell how much live data a particular Hyperview is requesting per second.
This information in the lower right-hand corner of the Hyperview browser is visible at all times in the status
bar at the bottom of the Browser, and shows you exactly what data fetch load you are placing on the system.

The Send/s  field shows how many requests Hyperview is making per second, from all sources (Watch
Window, Live Loop Annotations, and live data directly on documents), while the Recv/s  field shows how
much data is actually being received from the CIU or serial port module. If the send rate is approaching the
system data rate constraint (10-20 values per second per CIU), you need to take steps to reduce the data
load in order to avoid performance degradation.

Keep in mind that the load from all Hyperview users has to be added together to really know what you can
get from your CIU or CIUs.

For a global picture of data load, including requests from all Hyperviews and any other applications
requesting data from CIUMon, you can view the CIUMon statistics. Using CIUMon options, or using
CIUMonController.exe for CIUMon installed as a service, you can turn on statistics showing who is asking for
data, and how much data they are trying to get. This can help a lot in sorting out the load on the system.

90



2.13  Hyperview Keyboard Shortcuts

A Attributes/Tag Names F1 Open Help

F Full Screen F5 Refresh

J Split Adjust F6 Switch to Opposite Pane

S Toggle Specs Ctrl+N New Window

V Vegas Lights Ctrl+A Select All

W Watch Window... Ctrl+C Copy Selection

X Display Cross References Ctrl+V Paste

Y Synch Table of Contents Ctrl+D Define Bookmark

Z Zoom Toggle Ctrl+F Full Text Search...

+ Zoom In Alt+D Database Search...

- Zoom Out Alt+T Search All Titles...

Alt+Home Back to Home Ctrl+Tab Highlight Hotspots

T Table Of Contents H Next Highlight in Topic

Ctrl+T Table Of Contents As Tree Shift+H Previous Highlight in Topic

B Browse to Next Topic Ctrl+P Print...

Shift+B Browse to Previous Topic P Fast Print...

L Link to Next Index Entry Backspace Back

Shift+L Link to Previous Index Entry Shift+Back Forward

M Turn on Snapshot Mode/Refresh Data Double M Turn off Snapshot Mode

Shift-M Turn off Snapshot Mode
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